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Thank you for choosing our product. If there are any questions, or requests, please do not hesitate to 

contact the dealer. 

Disclaimer 

 
CAUTION! 

The default password is intended for your first login. For security, please set a strong password 
after your first login. A strong password shall include at least eight characters including uppercase 
letters, lowercase letters, and digits. 

 

 Contents of this document are subject to change without prior notice. 

 Best effort has been made to verify the integrity and correctness of the contents in this 

document, but no statement, information, or recommendation in this manual shall constitute 

formal guarantee of any kind, expressed or implied. We shall not be held responsible for any 

technical or typographical errors in this manual. 

 The illustrations in this manual are for reference only. 

 Due to uncertainties such as physical environment, discrepancy may exist between the actual 

values and reference values provided in this manual. The ultimate right to interpretation resides 

in our company. 

Conventions 

Convention Description 

Boldface font 
Commands, keywords, parameters and GUI elements such as window, tab, 
dialog box, menu, button, etc. 

Italic font Variables for which you supply values. 

> 
Separate a series of menu items, for example, Device Management > Add 
Device. 
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1  Introduction 

The Video Management Software is a device management suite. It provides video surveillance 

services including live view, playback, device management, recording schedule, alarm configuration, 

video wall, people counting and e-map. The suite is easy to deploy and operate, suitable for small 

and medium-size applications such as for super market, parking lot and residential area. For more 

details, see datasheet. 

Note 

 The software has different versions. Install on a compatible operating system. Please refer to 

the datasheet for detailed information. 

 The functions may vary, depending on factors including but not limited to, software version, 

device and version, and how the device is managed by the software (i.e., directly connected 

camera or NVR connected camera, see Glossary). 

 The PC that runs the software shall meet performance requirements (see datasheet for 

reference). The requirements may vary, depending on how you use the software. For example, 

live view at high resolution in multiple windows requires higher system capacity. 

 This manual is not intended for a specific software version. Some functions or features 

described in this manual may be available to certain version(s) only. 

Glossary 

 Video Management Software: Referred to as the software hereafter for short. Unless otherwise 

specified, the software in this manual refers to the Video Management Software. 

 Directly connected camera: Camera that is directly managed by the software (in comparison 

with NVR connected camera). 

 NVR connected camera: Camera that is managed by the software via an NVR (in comparison 

with directly connected camera). 

 IPC: IPC, IP camera and camera refer to the same thing in this manual. 

 PC: The computer that runs the software. 
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Typical Application 

 

2  Startup 

Double-click  to start the software. Log in with the default username/password 

(admin/123456). Please set a strong password for security in User Management. 

 
NOTE! 

The password for admin (123456 or others) does not change after an upgrade or a reinstall. 

 

Table 2-1 Buttons on the Main Window 

Icon Description 

 System menu 

 Lock account 

 Switch to another user 

 Open user manual 

 
View latest alarms, turn on/off alarm sound, enable/disable Display 
Alarm-Triggered Live View. 
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Icon Description 

  View system messages 

  Manage download tasks 

 Current user 

3  Live View 

Add an Encoding Device 

Add an encoding device (IPC or NVR) for live view. 

 
NOTE! 

 Managing a device with different management software programs may cause unexpected problems. 

 Always add devices as admin (by entering username "admin"). 

 

Click Device Management on the control panel and then follow the steps: 

1. Click Device > Encoding Device. 

 
NOTE! 

 The software automatically searches online devices on the LAN and lists the discovered on the 

Online Device list. The list refreshes periodically. To refresh the list manually, click . 

 To search a specified network segment, click  and select the Search Segment check box. 

 On the Online Device list, you can edit a device's IP address or open its Web page with a right-click 
on the device. Only admin can change a device's IP address. 

2. Select device(s) on the Online Device list and click . A pop-up menu appears. Click Add to 

add to the default group; or click Add to Group to add to a specified group. The added devices 

are named in device model_IP format (e.g., IPC_206.10.252.133) on the Managed Device list. 
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3. On the Managed Device list, you can: 

To How To 

Add more 
device(s) 

1) Click Add. 

 To add one device, select IP/Domain, and then enter the device's IP address, 
port, username (admin) and password. 

 To add devices with sequential IP addresses, select IP Segment, enter the 
start and end IP addresses, port, username (admin) and password. 

 Add a device by EZDDNS. First you need to enable DDNS on the device and 
complete relevant settings (such as DNS server, port mapping, domain 
name); make sure the PC and the DDNS server are connected, and then 
enter the domain name, username and password of the device on the 
software. This function is not available to the Mac version.  

2) Click Add to add to the default group; or click Add to Group to add to a 
specified group. 

Edit or delete a 
device 

Select the device and then click Edit or Delete. 

Restart a device 
Right-click the device and then click Restart.  

Caution: This operation will affect service. 

Access Web page Right-click the device and then click Configuration. 

View device 
status 

Click Status. 

 

Add a Group 

Click Device Management on the control panel and then follow the steps: 

1. Click the Group tab. 

2. Click Add Group. A dialog box appears. 

3. Enter a name for the group, e.g., Main Gate. 

4. Click Add. The new group appears on the group list. 
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5. You may delete or rename the group as needed. 

Import Cameras to a Group 

1. Click Import Camera. A dialog box appears. 

2. Select camera(s) on the left, and click to select the group on the right. 

3. Click Import Selected to import the selected camera(s); or click Import All to import all. In the 

dialog box, you may create new groups, remove cameras from a group, or rename cameras. 

 

Play Live Video 

Click Live View on the control panel and then follow the steps. 

Play Live Video in a Window 

1. On the Camera tab, double-click the camera or drag it to a window. 

2. To play a certain stream type (e.g., main, sub or third stream; options may vary with camera), 

click the button as shown below. 
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Live View Toolbar 

The live view toolbar is at the bottom of the live view window. 

Table 3-1 Live View Toolbar Buttons 

Button Description 

 Set screen layout. 

 
Custom screen layout. Drag the mouse to select screens and then click 
Join. Up to five custom layouts are allowed. 

 Save the current view. 

 Save the current view as another name. 

 Close all windows playing videos. 

 Play the live video of the previous camera or view. 

,  Pause/Resume sequence display. 

 
Adjust sequence display interval. 

 Play live video of the next camera or view. 

 
Adjust the MIC volume or mute the MIC for the PC in two-way audio. 

 
Switch to full screen. Press Esc to exit. 

 

The window toolbar appears when the mouse pointer hovers on a window playing live video. 
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Table 3-2 Live View Window Toolbar 

Button Description 

 
Take a snapshot. The storage path is configurable in System 
Configuration. 

,  
Record video to your PC (known as local recording). The storage path is 
configurable in System Configuration. 

 Available to PTZ cameras only. Click to open the PTZ control panel. 

 

Fisheye control, set mount mode and display mode to get desired images: 

 Mount: Ceiling, Wall, Desktop 

 Display Mode: Original Image, 360° Panoramic+1PTZ, 180° Panoramic, 
Fisheye+3PTZ, Fisheye+4PTZ, 360° Panoramic+6PTZ, Fisheye+8PTZ, 
Panoramic, Panoramic+3PTZ, Panoramic+4PTZ, Panoramic+8PTZ 
(clicking Original Image switches from dewarping mode to normal 
mode). 

Note: 

 This function is not available to the Mac version. 

 The fisheye control button is available to fisheye cameras only. 

 In dewarping mode, you may click a PTZ window and then use the 
mouse to drag the image, or zoom in/out using the scroll wheel; or 
click a panoramic window and then drag, zoom in or out on the 
demarcation area. 

 Digital zoom is disabled in dewarping mode, and the digital zoom 
button is hidden. If you switch to dewarping mode when digital zoom 
is enabled, digital zoom will be disabled automatically, and the image 
restores its original size. 

 Dewarping mode is not available when resolution is below than D1, 
and the fisheye control button is grayed out. 

,  

Enable or disable digital zoom. When enabled, drag the mouse to draw 
an area on the image to zoom in on, and then use the scroll wheel to 
zoom in or out. 

,  Mute or adjust speaker sound volume for your PC. 

 

Start instant playback (play video of the last 5 minutes and 30 seconds). 
Live video does not resume automatically when instant playback stops at 
the end. You need to resume live video manually. 

 Current bit rate and resolution (example). 

Shortcut Menu of Live View 

A shortcut menu appears when you right-click a live view window. Some items on the menu are 

described in the table below. 

Parameter Description 

Stream Type Select a stream type for the current window: Auto, main, sub and third stream 
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Parameter Description 

(options may vary with device). 

Note: 

 Sub and third stream are available when the device supports. 

 This feature is unavailable in sequence display. 

Manual Alarm 

Trigger an alarm manually. 

Note:  

It is recommended you configure an action first (see Configure Alarm-Triggered 
Action). A click of this button will generate an alarm and trigger the configured 
action. 

Camera Info 
Display frame rate, resolution, bit rate, video compression format, and packet 
loss rate for the window. 

Play Local 
Recording. 

Open the folder containing local recordings on your PC and play in the current 
window. 

Play Live Video by View 

By default view 

Play live video from cameras on the camera list by a default view. 

Example: Play live video from 4 cameras by the 4-Split view. 

1. On the View tab, click the Play button.  

 

2. Live video plays in four windows as shown below. 

Cam 1 Cam 2

Cam 3 Cam 4

 

By custom view 

Play live video from specified cameras by a custom view. 

1. On the View tab, click the button to create a view. 
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2. Click the Layout button to set the desired layout. 

3. Drag camera(s) to the intended windows one by one. You can drag image to switch windows. 

4. Click the Save View button, or click Save View As. 

5. Click the Play button. Live video from the specified cameras plays in the set windows in the set 

layout. 

 

PTZ Control 

Control the pan/tilt, zoom, focus, wiper of a PTZ camera and set presets and patrol route. 

 
NOTE! 

PTZ control is available to PTZ cameras only and it may vary depending on the camera's capability 
and the protocol it supports. For example, some manufacturers reserve certain presets for special 
use such as wiper or menu. Please refer to camera specifications before use. 

 

1. Click the live view window and then click  on the toolbar. The PTZ control panel is displayed. 
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2. Use the control panel as described in this table. 

Parameter Description 

 

Control rotation direction or stop rotation. 

Tip:  

With 3D positioning disabled, hover the mouse pointer on the live view 

window. When the shape changes to like , click and hold the left button 
to rotate the camera. 

 

Adjust focus and zoom. 

 

 Control the light. 

 Control the wiper. 

 Control the IR. 

 Control the heater. 

 Control the snow removal function. 

 Adjust rotation speed. 

 

 

With 3D positioning enabled, the camera automatically rotates when you 
click anywhere in the window. Drag the mouse from top left to bottom 
right to zoom in on the image, or drag reversely to zoom out. 

 

 Preset list. 

 : Click to go to a preset. 

 : Click to add a preset. Use an unused preset number when 
adding a new preset; otherwise, the existing preset will be replaced. 

 : Click to delete a preset. 
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Parameter Description 

 

 Patrol route list. 

 : Click the button to start recording a patrol route. When the 
recording starts, rotate the camera to desired directions and adjust 
zoom as needed. Actions are recorded and added to the action list. 
Click the button again to finish recording. 

 : Click to start a patrol route. 

 : Click to delete a patrol route. 

 : Click to set patrol, including patrol route info and patrol plan. 

On the Patrol Route Info tab, enter the route number and name. Click 
Add to add an action. Use Up, Down, Set Top and Set Bottom to 
change the order of the actions. Actions include: 

 Go to a certain preset with a specified duration of pause; 

 PTZ movement with specified direction, zoom, speed, duration and 
pause. Check Keep Rotating to make the camera rotate constantly. 

 On the Patrol Plan tab, configure your daily patrol plan. 

Sequence Display 

Sequence Display by Camera Group 

Play live video from cameras in a group one by one in a window. For the steps to create a group and 

import cameras to the group, see Add a Group. 

Example: Sequence display by Default Group (with 2 cameras: IPC1 and IPC2) 

1. Click to specify a window. 

2. On the Camera tab, click the button and then click Sequence Display on the pop-up window. 

 

3. Click  or  to pause or resume, click  or  to play the previous or next camera in 

the group, click  to change the interval. 
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Sequence Display by Default View 

Play live video from cameras on the camera list in sequence based on a default view. 

Example: Sequence display 8 cameras by 4-Split view at 20s interval. 

1. On the View tab, click the Sequence Display button. 

 

2. The sequence display is as illustrated below. 

Cam 1 Cam 2

Cam 3 Cam 4

Cam 5 Cam 6

Cam 7 Cam 8

20s 20s
Cam 1 Cam 2

Cam 3 Cam 4

…...

 

3. Click  or  to pause or resume, click  or  to play the previous or next, or click  

to change the interval. 

Sequence Display by Custom View 

Play live video by custom views in sequence. 

Example: Sequence display three custom views. 

1. On the View tab, click the Sequence Display button. The custom views play one by one at the 

set interval. 
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2. Click  or  to pause or resume, click  or  to play the previous or next view, or click 

 to change the interval. 

4  Recording and Playback 

Record videos, search recordings for playback or download. 

Configure a Recording Schedule 

 
NOTE! 

 The function is not available to the Mac version. 

 This function is available to NVR-connected cameras only. 

 

Click Recording Schedule on the control panel and then follow the steps. 

1. Select the camera for which you want to configure a recording schedule. 

2. Select to enable recording schedule. 

3. Use the mouse to draw a schedule on the calendar. The default schedule is 24/7. 

4. Click Save. 

5. To apply the same recording schedule to other cameras, click Copy To and then select cameras 

in the dialog box. 

Example: 

1

2

4 5

3

 

Tips: 

 In addition to drawing with the mouse, you may also input an exact time. 

 Use Copy To to apply same settings to another day (e.g., Sunday). 

 Click  to clear the calendar. 
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 You may specify a particular day as a holiday and apply a recording schedule for this day only. 

Record Video Manually 

Save live video to your PC as local recording by clicking the Start Local Recording ( ) and Stop Local 

Recording ( ) buttons on the window toolbar. 

Tips: 

 The default path and file format for local recording is configurable. See System Configuration. 

 You can play a local recording by dragging it to a live view window. 

Play Remote Recordings 

Search and play remote recordings such as recordings saved on an NVR or an SD card. 

 
NOTE! 

The Mac version does not support search and playback of recording saved on an SD card. 

 

Click Playback on the control panel and then follow the steps. 

1. Click the Device tab. 

2. Click View or Camera to choose a query mode: 

 View: Query recordings of cameras in a custom view. Make sure a recording schedule has been 

configured for cameras in the view. 

 Camera: Query recordings of the selected cameras. 

3. Select camera(s) or select a view, depending on the mode you have selected in step 2. 

4. Select a date. 

5. Select a recording type if necessary. 

Example: 
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1

2

3

4

5

 

 
NOTE! 

 A query allows up to 16 cameras at a time. The extra cameras are ignored. 

 The calendar uses different colors to indicate different recording status: white means no recording, 
blue means general recording, red means alarm recording. This feature is not available to the Mac 
version. 

 

6. Click Timeline or File. 

 Timeline: Click a window and then click the play button (B) to start playback; or click anywhere 

on the timeline to start playing video from that point. 

Example: 

EB C D F HA

J

J

I A

G

 

Table 4-1 Timeline Operations 

Button Description 

A Move the timeline forward or backward. 

B Start/pause playback. 

C Close all windows. 

D 
Not available to the Mac version. 

Play by frame. Click to play the next frame of image. 
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Button Description 

E Adjust playback speed. 

F 

Switch to synchronous playback. 

Note:  

Synchronous playback is applicable to remote recordings only. 

Frequent operations (such as pause/resume, adjustment of speed) during synchronous 
playback degrade the performance. 

G See Smart Search. 

H Switch to full screen mode. Press Esc to exit. 

I Corresponding time where the mouse pointer rests. 

J Zoom in or out on the timeline scale. 

 

 File: Double-click a file to start playback; or select camera(s) or file(s) and then click the button 

to download. 

Figure 4-1 Recording Search Results-File 

 

 

7. Use the window toolbar during playback. 

Example: 

A B C D E  

Table 4-2 Playback Window Toolbar Buttons 

Button Description 

A 
Take a snapshot and save it to your PC. The storage path is configurable (see System 
Configuration). 

B 
Digital zoom. When enabled, drag the mouse to draw an area on the image to zoom in 
on, and use the scroll wheel to zoom in or out. 

C Clip video to download. 

D Mute or adjust speaker sound volume for your PC. 

E Current bit rate and resolution. 
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NOTE! 

 The  button is displayed on the toolbar for a fisheye camera (not available to the Mac version). 

 Before playing a recording, you can set the video transmission protocol based on the network 
environment to improve the image quality. 

Play Local Recordings 

Search and play recordings saved on your PC. 

1. Click the Local tab. 

2. Select camera(s). 

3. Set a time range. 

4. Select Recording. 

5. Click Query. Search results are displayed. 

Example: 

1

2

3
4 5

6

 

6. Double-click the file to start playback. 

View Local Snapshots 

Search and view snapshots on your PC. See Play Local Recordings. Operations are similar. The major 

difference is that you select Picture in step 4. 

Download 

Use the following methods to download recordings to your PC. 

 Use clip buttons (  and ) in a playback window. See Playback Window Toolbar Buttons. 
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 Select files to download and then click . See Recording Search Results-File. 

 Click  and then set the time range. 

1

2

1

2

 

 To manage download tasks, click the task management button at the bottom (see Buttons on 

the Main Window). A dialog box appears. 

 

Tips: 

 Stopping a download task does not remove the video that's already downloaded. 

 The default path and file format for downloading recording is configurable. See System 

Configuration. 

 VLC player is a recommended media player. You can also play a downloaded video by dragging 

it to a live view window. 

Smart Search 

This function is available when the software works with certain NVR models and versions. 
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Smart search searches recordings for smart results (such as motion) and playback. VCA recordings 

are not applicable. 

1. Start the playback of the recording you want to perform a smart search. See Play Remote 

Recordings for the steps. 

2. When playback starts, the Smart Search button (
 

) is activated. Click this button. 

3. You will find the entire screen is covered with green grids (see the figure below), which means, 

the entire image will be searched. To edit the search area, click or drag on the image. 

 

4. Adjust search sensitivity as needed. The higher the sensitivity, the more likely that tiny motion 

activity will be detected. 

5. Click 
 

 to start smart search. Search results appear on the timeline, and the video starts 

playing from the beginning. 

Example 

 

Tips: 

 Green means video with motion detected. 

 The green part plays at normal speed; other parts play at high speed to save time. 

6. To edit search area or sensitivity, click ; to exit smart search, click . Note that clearing 

the checkbox for the camera on the camera list will also exit smart search. 
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5  DX Video Wall 

 
NOTE! 

 This function is not available to the Mac version. 

 The number of video walls supported, operations allowed, and functions available may vary with 
device and version. 

Add a Decoding Device 

Search decoding devices or add directly. See Add an Encoding Device for reference; or add an NVR 

with a decoding card. 

 
NOTE! 

Add decoding devices as admin. 

 

Add a Video Wall 

Click DX Video Wall on the control panel. For first time use, click  and follow the 

steps. 

1 2

3

4

5

6
 

1. Enter the video wall name. 
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2. Click  and set the video wall size according to the physical video wall. 

3. Select a decoding device. Decoding channels are displayed. 

4. Set the resolution. 

5. Drag decoding channels to screens one by one to complete binding. To cancel binding for a 

screen, click the close button in the top right corner. To cancel all bindings, click . 

6. Click OK. The video wall is created. 

7. To edit or delete a video wall, click the arrow . 

Video Wall Operations 

1. Click  to open windows on the video wall. 

2. Drag cameras to intended windows to start live video. 

 

Tip: To start live video from multiple cameras or camera group(s), select the cameras or camera 

group(s), click a window and then click Play on Screen or Play on Wall. 

 Play on Screen: Play on one window. 

 Play on Wall: Play on multiple windows. 

3. To sequence display (play cameras from a group in sequence), drag a camera group to the 

intended window. 

Note: If the video wall is created using an NVR's decoding card, sequence display is only available to 

cameras that are connected to the NVR. 

4. To play signals from the local signal source, drag the signal source to the intended window. 

5. To play alarm-triggered live video on a window, right-click the window and click Set Alarming 

Window. Only one window can be set as alarming window. Make sure alarm-triggered live 

video is configured (see Alarm-Triggered Action for details). To cancel the setting, right-click the 

window and click Cancel Alarming Window. 
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Note: If the video wall is created using an NVR's decoding card, alarm-triggered live video is only 

available to a camera that is connected to the NVR. 

6. For more video wall operations, see the tables below. 

Figure 5-1 Video Wall Control 

A B C

H

D E F G

I J K L

M N N

Q R
O P

 

The buttons are effective to all windows on the video wall. 

No. Description 

A 
Save current settings as a scene, including the window layout and service (live video or 
sequence). The saved scenes are listed on the Scene tab. Click Start to restore the current 
service. 

B 
Open window(s). Before you can perform any operation, you need to open windows on 
the screen first. 

C Close all windows. 

D Start decoding in all windows. 

E Stop decoding in all windows. 

F 

To open a custom window, click this button, drag on the screen to open window(s), and 
then click this button again to complete. 

Tip: You can drag the border of a window to resize, or drag a window to relocate. 

G 
Click to renumber windows. Each window has a number in the top right corner. Clicking 
this button will number all the windows according to their position by this rule: from top 
to button, from left to right. 

 

Figure 5-2 Window Control A B C

H

D E F G

I J K L

M N O

R S
P Q

 

The buttons are effective to a window. 

No. Description 

H Split a window. 

I/J Start/stop decoding in the window. 

K Specify a window that always displays at the bottom when multiple windows overlap. 

L Display a window in full screen mode. 

M/N/O Current camera, stream type, and preset (of a PTZ camera). 
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No. Description 

P 
Search recordings for playback. 

Note: Available to NVR-connected cameras only. 

Q Close the window; or click the close button in the top right corner. 

R Hide or display the window control area. 

S 

Available to certain decoding devices only. 

Display text on video images with custom font, size, alignment, color, background color 
and transparency. 

Figure 5-3 

Appears for sequence display (play live video from cameras in a group in sequence). 

Click the buttons to pause, play the previous or next camera(s) in the group, or set the 
sequence display interval. 

Figure 5-3 Sequence Display Control 

 

6  People Counting 

 
NOTE! 

 This function is not available to the Mac version. 

 This function is only applicable to NVR-connected cameras.. 

 

Click People Counting on the control panel and then follow the steps to display counting statistics. 

1. Select the camera. 

2. Set search conditions, including the report type, counting type and date. 

3. Click Search. Search results appear on the right side. 

4. Click an icon to hide or display data on the chart. 

5. Click to display data using a line chart or column chart. 

6. Click to export statistics. 
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1

2

3

4 5

6

 

7  E-map 

Preparations 

Before you can use the e-map, you need to add an e-map first and then add hot spots and hot zones. 

Add an E-map 

Click E-map on the control panel and then follow the steps. 

1. When you access E-map for the first time, click Add Map. 

2. Enter the map name, select the map image, and then click Add. The map is added, for example. 
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3. To edit the map name or choose a different map image, click Modify Map on the top toolbar. 

4. To delete a map, click Delete Map. Deleting a map will delete all hot spots and hot zones on it. If 

the deleted map has a parent map, the parent map is displayed. 

5. You can drag and zoom in or out on the map. 

Add a Hot Spot 

A hot spot is a camera on the e-map. 

1. Drag cameras to intended locations on the map. 

2. To change the color of a hot spot, right-click the hot spot and then choose a color. 

3. To delete a hot spot, right-click the hot spot and then click Delete; or click Delete Hot Spot on 

the top toolbar. 

4. To locate a hot spot on the map, click the Locate button. 

 

Add a Hot Zone 

A hot zone is a child map on the map. 

1. Click the Add Hot Zone on the top toolbar. 

2. Enter the zone name, select an image file for the zone, and then click Add. The hot zone appears 

on the map as a small red icon. 

3. Drag the hot zone to the intended position on the map. To change color or delete the hot zone, 

right-click the hot zone. 
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4. To change the zone name or choose a different image file, select the zone and click Modify Hot 

Zone on the top toolbar. 

Map Operations 

After you complete configuration on the Edit tab, click the Preview tab to perform map operations. 

View Live Video from a Hot Spot 

Double-click a hot spot on the map for live video; or double-click the camera on the camera list. 

View a Hot Zone 

Double-click the red icon on the map. The hot zone is displayed. Click Back to Parent Map in the top 

right corner to go back to the parent map. 

View Hot Spot/Hot Zone Alarms 

When a hot spot (including those in a hot zone) reports an alarm (e.g., motion detection), the hot 

spot or hot zone icon blinks red on the map. Right-click the hot spot icon and click Show Alarm Info 

to view alarm info. To view hot zone alarms, double-click the hot zone icon to open it and then view 

alarm info of the corresponding hot spot. 

 

Clear Hot Spot/Hot Zone Alarms 

To clear hot spot alarms, right-click the hot spot icon and then click Clear Alarm. To clear hot zone 

alarms, double-click the hot zone icon to open it, and then clear the corresponding hot spot alarms. 

You may also select a hot spot and then click. 

You may also use the  button to clear alarms. The hot spot or hot zone restores to 

normal status when alarms are cleared. 
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8  Audio 

Audio service includes audio and two-way audio. The services are exclusive to each other, which 

means, starting one will stop another. 

Audio 

When live video is playing, turn on audio from the camera by clicking  (see Live View Window 

Toolbar). The audio is one-way (from camera to PC) and it stops with live video. 

Note: Audio is available for one camera at a time. 

Two-Way Audio 

Two-way audio is audio communication between a device (camera or NVR) and the PC. Both the 

device and the PC shall be connected to audio input and output devices. 

When live video is playing, right-click the window and click Two-way Audio. To stop two-way audio, 

deselect Two-way Audio. 

Note:  

 Two-way audio with an NVR is not available to the Mac version. 

 One two-way audio is available at a time. 

9  Alarm Management 

Configure action(s) to trigger when an alarm of a certain type occurs at a specified source; view 

latest or history alarms, and export alarm records to your PC. 

Configure Alarm-Triggered Action 

Click Alarm Configuration on the control panel and then follow the steps. 

Example: 
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1

2

3

4 5

6 7

8

9

 

1. Select a type. Take Camera Alarm as an example. 

2. Select the alarm source. An alarm source will trigger the configured actions. 

3. Select an alarm type. An alarm of the specified type will trigger the configured actions. 

4. Configure alarm parameters (required for certain alarm types such as motion detection). For 

some alarm types, you need to configure alarm parameters in the Web interface of the device. 

5. Click the Trigger Actions tab. 

6. To receive an email notification when an alarm occurs, select the check box. 

7. Configure email parameters (see System Configuration). 

8. Click Add. A dialog box appears. Select the devices to trigger and then click OK. The selected 

devices appear on the list. These devices will be triggered to perform the specified actions when 

an alarm of the specified type (step 2) occurs at the specified source (step 1). 

9. Configure actions to trigger: 

 Alarm-triggered live view: An alarm will trigger live video from the camera in a pop-up window. 

See An Example of Alarm-Triggered Live View. 

 Alarm-triggered preset: An alarm will trigger the PTZ camera to rotate to the preset. The presets 

in the list need to be configured beforehand. 

 Alarm-triggered output: An alarm will trigger the camera to output an alarm so as to trigger an 

action by a third-party device. 

 Alarm-triggered video wall (not available to the Mac version): An alarm will trigger the video 

wall to play live video from the camera. You need to complete video wall configuration first. 

Only one camera can be selected. 

 
NOTE! 

 For alarm-triggered live view to take effect, click  in the bottom left corner (see Buttons on the 
Main Window) and select Display Triggered Live View. 

 Triggering live video from multiple cameras may cause high CPU usage and affect other services. 
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Figure 9-1 An Example of Alarm-Triggered Live View 

1

2

763 4 5

 

 1: Alarm time and alarm source. 

 2: Triggered device(s) and corresponding window number. 

 3: Set screen layout. 

 4: Lock the current layout. 

 5: When selected, the current live video will not be replaced by subsequent alarm-triggered live 

video. 

 6: Switch to full screen. Press Esc to exit. 

 7: View alarm records. 

View Alarm Records 

Click Alarm Records on the control panel to view alarm records, acknowledge alarms, and export 

alarms to your PC. 

Latest Alarm 

The Latest Alarm tab list the latest alarms since your current login. The list refreshes automatically. 
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 To acknowledge alarm(s), double-click an alarm; or select alarms and then click Acknowledge. 

Alarms disappear from the list once acknowledged. 

 To select all the currently displayed alarms, click . 

 Sort the list by clicking a table header: Alarm Time, Device Name, Alarm Type and Alarm Level. 

 To turn on alarm sound, click . 

History Alarm 

Click the History tab to view history alarm records. 

To make a query, select check box(es) and set query condition(s). Clicking Reset will disable the 

current query conditions. 

Example 

 

 To view detailed info about an alarm, select the alarm and click Details. 

 To acknowledge an alarm, select the alarm and click Acknowledge. 

 To export the currently displayed alarm records and save to your PC, click Export. Alarm info is 

saved in a CSV file. Use Microsoft Excel to open it. 
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 To select all the currently displayed alarms, click . 

10  Operation Logs 

Click Operation Log on the control panel to query logs or export logs to your PC. 

Example: 

 To make a query, select check box(es) and set query condition(s). Clicking Reset will disable the 

current query conditions. 

 Click Export to export the currently displayed logs to a CSV file. 

11  Others 

System Configuration 

Click System Configuration on the control panel to configure the following parameters. 

Parameter Description 

Audio & 
Video 

Video 

Processing 
Mode 

Normally Short Delay is recommended; Fluent is 
recommended if network transmission has delay. 

Display Mode Set according to the display capability of your PC. 

Stream 
Transmission 
Protocol 

Transmission protocol for a camera to send video data 
to the display window. The changed setting takes 
effect at the next startup of the software. 

Note:  

 TCP is recommended in poor network conditions. 

 For UDP, make sure the software is not blocked by 
the firewall. 

Enable GPU 
Mode 

Not available to the Mac version. 

When enabled, the software can start stream for more 
cameras. 

Enable VCA 
Rule 

Not available to the Mac version. 

When enabled, VCA rules display on the live video of 
the camera that supports this function. 

Enable 
Shortcut PTZ 
Control 

Not available to the Mac version. 

When enabled, shortcut PTZ control is available. 
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Parameter Description 

Picture 
Snapshot 
Format 

 BMP: Non-compressed images and require more 
space. 

 JPEG: Compressed images and require less space. 

Note: The default format is JPEG. To get better image 
quality, select BMP. 

Recording 

Local/ 

Downloaded 
Recording 
Format 

Format of local/downloaded recordings: TS and MP4. 

System 

Startup 

Enable Auto 
Login 

When enabled, automatically start the software and 
log in after you log in to the operating system. 

This function only applies to admin. 

Enable Auto 
Login to 
Windows 

Not available to the Mac version. 

When enabled, automatically log in to Windows with 
the provided username and password at startup. 

Log 

Save 
Operation 
Log For 

Retention period for operation logs. 

Save Alarm 
Log For 

Retention period for alarm logs. 

Maintenance 

Import 
Configuration 

Import configurations from a configuration file. 

Export 
Configuration 

Export configurations to save as a file. 

Operation 

Alarm 
Enable Alarm 
Sound 

If enabled, you can custom alarm sound duration and 
set different sounds for different alarm types. 

Service 
Enable Auto 
Time Sync 

If enabled, the software syncs the PC's system time to 
cameras. 

Interval: Synchronization interval. 

Email 

Required for alarm-triggered email (see Configure Alarm-Triggered 
Action). The specified email address(es) will receive an email when an 
alarm occurs. 

 Sender: Email address used to send emails. 

 Recipient: Email address used to receive emails. 
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Parameter Description 

Tip: Use the sender address as the recipient and click Send Test Email 
to make a test. 

User Management 

Click User Management on the control panel to add, edit or delete users. 

Use the default username/password (admin/123456) to log in. "admin" is the super administrator 

and cannot be edited or deleted. 

1. To add a user, click Add: 

 Administrator: Only admin can add administrator. Administrator has all permissions by default. 

 Operator: Admin or administrator with user management permissions can add operators. An 

operator has no permission by default. 

2. To edit a user such as password, double-click the user on the list; to delete user(s), select and 

click Delete. 

 
NOTE! 

Menus may be grayed out or hidden for lack of permission. Contact admin if necessary. 

Cloud Device Management 

Click Device Management on the control panel and then follow the steps. 

1. Click Device > Cloud Device. 

2. If you already have a cloud account, proceed to step 3; otherwise, click Register to sign up. 

3. Enter your username and password for your cloud account, and then click Login. Devices under 

your cloud account appear. 

4. To add a device to your cloud account, click Add. The register code is displayed in the Web 

interface of the device. See device documentation for details. The device is on the My Cloud 

Device list. 

Tips: You can view live video from online cloud devices (IPC or NVR) like local devices. 

On the My Cloud Device list, you can: 

 Add or delete a cloud device. 

 Double-click a device to change its name. To sync the new name to cloud, select Sync to Cloud. 

 Click Share to share with another cloud account. Permissions are pre-configured on the device. 

 Click Sharing Records to view sharing history. 

The Shared Cloud Device list lists devices shared to you by other cloud accounts. Clicking Cancel 

Sharing will stop sharing. 
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Multi-Monitor Display 

If your PC is connected to two or more monitors, you may use this function to view live video in up to 

4 monitors. The auxiliary monitor(s) are for live view only; configurations are still performed on the 

main monitor. 

Just click Live View on the control panel to open new live view windows according to the number of 

monitors connected. 

Multi-Window Display 

Drag a tab to open a new window. 

Example: 
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	1. Click the Add Hot Zone on the top toolbar.
	2. Enter the zone name, select an image file for the zone, and then click Add. The hot zone appears on the map as a small red icon.
	3. Drag the hot zone to the intended position on the map. To change color or delete the hot zone, right-click the hot zone.
	4. To change the zone name or choose a different image file, select the zone and click Modify Hot Zone on the top toolbar.


	Map Operations
	View Live Video from a Hot Spot
	View a Hot Zone
	View Hot Spot/Hot Zone Alarms
	Clear Hot Spot/Hot Zone Alarms


	8   Audio
	Audio
	Two-Way Audio

	9   Alarm Management
	Configure Alarm-Triggered Action
	1. Select a type. Take Camera Alarm as an example.
	2. Select the alarm source. An alarm source will trigger the configured actions.
	3. Select an alarm type. An alarm of the specified type will trigger the configured actions.
	4. Configure alarm parameters (required for certain alarm types such as motion detection). For some alarm types, you need to configure alarm parameters in the Web interface of the device.
	5. Click the Trigger Actions tab.
	6. To receive an email notification when an alarm occurs, select the check box.
	7. Configure email parameters (see System Configuration).
	8. Click Add. A dialog box appears. Select the devices to trigger and then click OK. The selected devices appear on the list. These devices will be triggered to perform the specified actions when an alarm of the specified type (step 2) occurs at the s...
	9. Configure actions to trigger:

	View Alarm Records
	Latest Alarm
	History Alarm


	10   Operation Logs
	11   Others
	System Configuration
	User Management
	1. To add a user, click Add:
	2. To edit a user such as password, double-click the user on the list; to delete user(s), select and click Delete.

	Cloud Device Management
	1. Click Device > Cloud Device.
	2. If you already have a cloud account, proceed to step 3; otherwise, click Register to sign up.
	3. Enter your username and password for your cloud account, and then click Login. Devices under your cloud account appear.
	4. To add a device to your cloud account, click Add. The register code is displayed in the Web interface of the device. See device documentation for details. The device is on the My Cloud Device list.

	Multi-Monitor Display
	Multi-Window Display


